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1. INTRODUCTION 
CCD-Guide is a project of Astronomischer Arbeitskreis Salzkammergut (AAS) ï Gahberg 
Observatory (www.astronomie.at). Since 1997, the CCD team of the Gahberg Observatory has 
published the best astrophotos of the members together with a software as CCD-Guide every 
year. The total revenue from the sale of CCD-Guide is used to assist the association and 
delivers a small financial contribution to the current AAS projects. 

1.1. Functionality 
A summary of the new functions of the current release can be found in the appendix (chapter 
18). CCD-Guide assists both, the beginner in astrophotography as well as the advanced 
astrophotographer with the following key features: 

 

¶ Image Browser: You can easily browse through more than 5,000 images. At the same 
time you can see object data, image data and a preview image. Double-click on the 
preview image to open the image in ObjectViewer. The access to additional images 
(e.g. image with object identification, inverted image,..) is also provided. 

 

 

¶ Objectname Filter: If you want to select all images, which show a particular object, 
simply enter the object name or an alias name of the object name. Proper names or 
even parts of object names often guide you to the searched images. 

 

¶ Quick Filter: When you enter a search string into the edit field of the QuickFilter, then 
only those data rows are shown which contain this search string in one of the data 
fields.  
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¶ Set Filter: You can easily create a subset of images using many different criteria (e.g. 
coordinates, object type, object size, constellation, catalogue, observer, camera, 
telescope, date, é) 

 

 

¶ Slideshow: After you have defined a particular subset of images using the set filter 
feature, you can start a slideshow to browse through all images in full screen mode. 

 

¶ No software installation necessary: All functions are available immediately after 
unpacking the zip file in the case of the download version or after copying from the USB 
stick to the hard disk in the case of the USB stick version. 

 

¶ ObjectBrowser: CCD-Guide contains a big database of objects including object data. 
The database contains 30 different catalogues of deep sky objects, which are based on 
the revised NGCIC catalogue of Wolfgang Steinicke, the nebula database of Eric-Sven 
Vesting and the NED and Vizier databases. A big advantage of CCD-Guide is that there 
exists only one data row for one object. Each physical object has a master object name, 
but you can find this object also with the alias names (entries in other catalogues). With 
the ObjectBrowser, all object data can be accessed easily and quickly.   

 

¶ Input your own objects: In case that some special objects are missing (e.g. comets), 
you can input your own objects including object data. 
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¶ Input your own images: You can input your own images including additional images 
and additional objects. 

 

 

¶ Planner: First, you can create different setups (telescope + camera combination). Then 
you can use the object database to create your planning list for each setup. A very 
useful feature of the Planner is the possibility to assign a reference image and a field-of-
view image to each planning data set. 
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¶ ObjectTracker: ObjectTracker answers quickly and easily the question whether a 
certain object can be photographed at a selected location in a certain night. The ideal 
time window for observing is calculated taking into account twilight, moon, object 
altitude and optional horizon. The altitude progression of the object and of the moon is 
displayed in an intuitive graphic. 
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¶ ObjectMarker & ObjectViewer: With the ObjectMarker, images can be solved via 
astrometry.net and then labeled with the objects of the CCD-Guide database as well as 
with your own texts. With the ObjectViewer the labeled images can be viewed, 
coordinates can be read out and an internet search can be carried out with SIMBAD, 
NED or Vizier. 
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1.2. CCD_Guide.exe 
The CCD_Guide.exe is the central entry point to the CCD-Guide software platform. All programs 
can be started directly here. 

 

 

The two most important programs that can be called from the CCD_Guide.exe are: 

¶ Browser (Browser.exe): allows access to all images including image data using the 
ImageBrowser function and easy access to the object database using the ObjectBrowser 
function. 

¶ Expert (Expert.exe): contains the CCD-Guide functions object planning, input of own 
objects and input of own images. 

Furthermore, the CCD_Guide.exe is the central point for help and information (Help button) and 
it allows direct access to the ObjectTools such as ObjectTracker, ObjectMarker, ObjectViewer 
and many other useful utilities. 

The CCD-Guide window can always be kept in the foreground with "Stay on top" (pin button) 
and with "Autostart" it can be started automatically when the computer is booted. 

Clicking on the small square changes the color scheme for all applications (except Expert) 
between light and dark. 

Click on the cogwheel symbol in the top right-hand corner to access the global settings of CCD-
Guide. 

If a blue info icon appears in the title bar, then a new update is available, which can be 
downloaded and installed with the Update Utility. 

 

 

Details on the individual tools of the CCD-Guide software platform can be found in the respective 
chapters of this manual. 
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2. INSTALLATION AND FIRST STEPS 

2.1. System requirements 

¶ Operating system: Windows 10 or higher (Windows 7 probably possible, but not tested) 

¶ CLR (Common Library Runtime) .net 4.5.2 or higher 

It is recommended to use CCD-Guide on a computer where all operating system updates have 
been carried out. 

2.2. Installation 
Installation of the software: 

The installation of the software is very simple for both the download variant and the USB stick 
variant:  

Unzip the zip-file to the desired directory on the internal or external hard disk: e.g. into the 
directory c:\ccdguide\ or d:\ccdguide\. 

 

Attention: Please, do not copy CCD-Guide into the Windows system folders like 
c:\Program Files, c:\Program Files (x86) or c:\Windows!   

 

Images on USB stick:  

If you have purchased an USB stick, please copy the folder images from the USB stick into the 
CCD-Guide directory on the hard disk. 

 

Attention: If the virus scanner causes problems, please follow the tips in the following pdf 
document: 

https://ccdguide.com/wp-content/uploads/2022/03/VirusScanner_EN.pdf 

2.3. Migration 
If CCD-Guide 2024 is installed on the computer, the migration window opens when 
CCD_Guide.exe is started for the first time. 
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If you do not want to migrate data from the previous version, click on the "Continue without 
migration" button.  

If you want to carry out a data migration, check the set source and destination directories and 
make the desired settings.  

You have the option of moving or copying the master images from the CCD-Guide 2024 
directory to the new CCD-Guide 2025 directory or not performing any action at all. Copying or 
moving the master images makes sense for the download version in order to reduce the 
download time for the new master images that are still missing. For the USB stick version, leave 
this option set to None. 

For the user data, there is also a choice between moving or copying the data or no action. The 
"Copy files" option is recommended here because the CCD-Guide 2024 version will remain still 
functional. 

If all settings are set correctly, start the data migration with the "Start migration" button. The 
migration may take several minutes depending on the settings made. Please wait until the 
migration process is complete and the "End migration and continue with CCD_Guide" button is 
available. After clicking this button, CCD_Guide.exe will start. 
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2.4. Image Downloader 
If you have purchased the download version of CCD-Guide, you will find the complete CCD-
Guide software including help documents in the downloaded zip file. However, due to the 
amount of data, all images are missing. 

The Image Downloader allows you to download the images from the CCD-Guide server. When 
you start CCD_Guide.exe, the Image Downloader window opens automatically as soon as 
images are missing. 

Alternatively, the Image Downloader can also be started manually at any time in the Global 
Settings of CCD_Guide.exe. 

http://www.ccdguide.com/
http://www.ccdguide.com/
http://www.ccdguide.com/


 

 

CCD-Guide 4.3 Manual 

Bernhard Hubl     http://www.ccdguide.com/ 

 2024-09-13 14 / 150 

 

 

The image download starts as soon as you press the Start button. You can pause the download 
process at any time using the Pause button. If necessary, you can also close the Image 
Downloader window and continue downloading the images in another session. 

If images are still missing, the Image Downloader window opens automatically each time 
CCD_Guide.exe is started.  

In the Global Settings of CCD_Guide.exe (cogwheel symbol top right) you will find all the options 
for downloading images on the Images tab (first tab). 
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The three parameters on this tab can also be changed in the event of problems with the image 
download. As a rule, it is recommended to leave these parameters unchanged. 

In addition to downloading the master images via the "Download images" button, it is also 
possible to download the archive images via the "Download archived images" button. Archive 
images are images of an older date that have been archived due to their lower quality and are 
therefore not included in the standard scope of delivery of CCD-Guide. To be able to use 
archived images in the Browser, a change in the Browser options is also required (see chapter 
3.10). 
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2.5. Global Settings and Options 
After completing the installation, it is recommended to check some program options and to 
change them if necessary. 

Global Settings in CCD_Guide.exe: 

You can access the Global Settings via the cogwheel symbol in CCD_Guide.exe. In addition to 
the image download function, you will find further settings here, which are described in detail in 
the respective applications.  

If you have already used the Plate-Solve with Astrometry.net or the ObjectTracker weather 
function in a previous release, then it makes sense to check or set the respective API keys in the 
Astrometry or ObjectTracker tab. 

In addition, a look at the System tab is recommended in any case: 

 

 

The wake-up key can be used to bring CCD_Guide.exe to the foreground if it has disappeared 
behind another window. The wake-up key is set to "F2" by default, but can be changed here if 
required.  

With the "Show in task bar" checkbox, the CCD_Guide.exe can be displayed as a normal 
application in the task bar if desired. 

At this point, it is also recommended to set the manual language so that the desired language 
always appears immediately when the help button is pressed. 

Creating locations, changing the active location or changing the color scheme is not necessary 
at this point because the location can also be edited and changed in the ObjectTracker and 
because the color scheme can be changed directly in the main window of CCD_Guide.exe. 
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Options in Browser: 

First start the Browser by clicking on the button Browser in the CCD_Guide.exe. After the 
Browser window has opened, click on the second menu item "Options". 

 

  

 

Various settings can be made in the Options window, which are explained in different places in 
this manual. The default settings make sense for most users and in the first step only the 
planetarium should be set. To do this, use the right scroll bar to get to the section "Planetarium 
software". 
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The default setting of Planetarium is ñObjectSkyò. You can select one of the following 
planetariums: 

¶ TheSky6 

¶ TheSkyX 

¶ SkyChart (=Cartes du Ciel) 

¶ Guide9 

¶ ObjectSky 

¶ Stellarium 

To use The Sky6 or TheSkyX in CCD-Guide, it is necessary to start The Sky once as 
administrator. 

To use Stellarium in CCD-Guide, the following setting is necessary in Stellarium: 

Plugins -> Remote control -> Activate checkbox "Load at startup". 

 

 

Options in Expert: 

Please start the Expert by clicking on the Expert button in the CCD_Guide.exe. After the Expert 
window has opened, click on the "Options" tab. 
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Please, check and modify the following paths: 

¶ Master image path: This folder contains all master images. There is no need to change 
this path. 

¶ User data path: This folder contains all user data including the user database, the 
archive of user images and the planner images of the user. 

 

Furthermore, you can activate or deactivate the visibility of tooltips in the Expert with the 
checkbox "Show Tooltips". 

The field separator for all csv export functions is defined in the ñField separator for csv Exportò 
dropdown field. 

It is necessary to click Save to set any changes in the Options tab. 
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2.6. Continuing to use an existing user.mdb 
If you are already a CCD-Guide user and would like to continue using your existing data from the 
old user.mdb, we recommend using the migration function (see chapter 2.3) The migration 
function is only available, if the previous release is 4.2 (CCD-Guide 2024) or newer. If the 
predecessor release is older, proceed as follows depending on the old CCD-Guide release: 

Release 3.3 or newer: 

¶ Copy the existing "userdata" directory from the old CCD Guide installation directory to the 
new CCD Guide installation directory (overwriting the existing user.mdb). 

¶ Update the paths in the Options tab as described above. 

Release 3.2 or older: 

¶ Copy your existing user.mdb from the subfolder ñdatabaseò of the old CCD-Guide 
installation into the subfolder Ăuserdatañ of the new CCD-Guide installation (Overwrite the 
existing user.mdb). 

¶ Copy your folder with the user images (user_images) and the folder with the planner 
images (planner_images) from the old CCD-Guide installation into the subfolder 
ñuserdataò of the new CCD-Guide installation. 

¶ Update the paths in Options tab. 

 

2.7. Further use of existing ObjectTracker locations and horizon files 
If you are already using ObjectTracker and you want to continue using the locations and 
horizons you have already created, then proceed as follows, depending on the old CCD-Guide 
release you have: 

Release 4.1 or newer: 

¶ No further action is necessary if you have already copied the "userdata" directory as 
described above. 

Release 4.0 or older: 

¶ Please copy the Locations.csv file and the hor directory from the objecttracker directory 
of the old CCD-Guide installation to the userdata folder of the new CCD-Guide 
installation. (Overwrite the already existing Locations.csv file). 
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3. BROWSER (IMAGEBROWSER AND OBJECTBROWSER) 

3.1. Browser - overview 
The Browser is the core of the CCD Guide software. At the same time you can see object data, 
image data and a preview image. A double click on the preview image opens the image with the 
ObjectViewer. 

 

 

 

You can use the arrow keys of your keyboard or you can simply click on a data row in the main 
table of the Browser to change the active data row. The active data row is bluely colored. The 
preview image is always connected with the active data row. Also the contents of the Extended 
Information table near the right top corner are always connected with the blue active data row. 

 

The horizontal control bar in the middle of the Browser window is the central control point of the 
Browser and offers a number of functions grouped as follows: 

 

 

¶ Filter functions (details in chapter 3.6) 

 
 

¶ Database access control (details in chapter 3.2) 

 
 

¶ Actions (details in chapter 3.7) 
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¶ Change Browser display (details in chapter 3.3 and in chapter 3.9) 

 

 

3.2. Database access control 
The Browser can be used in two different Browse modes: 

 

1. ImageBrowser: You can browse through all images of the CCD-Guide database. 

 

 

2. ObjectBrowser: gives you the possibility to browse through the object data of all objects 
of the CCD-Guide database. This mode is very useful for planning. 

 

 

The Database button  offers the choice between the following modes: 

¶ Master: is the default setting. Images and object data are only read from the CCD-Guide 
master database. 

¶ User: Images and object data are read from the user database. This option is only 
available if you have entered your own images or your own objects in Expert. 

¶ All: Images and object data are read from both the master database and the user 
database. 

 

3.3. Main data table 

The ListView button  (to the right above the main data table) gives you the 
possibility to change the appearance of the main data table in ImageBrowser mode: 

¶ Simple: Only the most important data columns are visible. 

¶ Image: Image related data columns are visible. 

¶ Object: Object related data columns are visible. 

¶ Full: All data columns are visible. 

¶ User: User defined data columns are visible. 
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You can modify the user defined data columns (include or remove data fields) by clicking on 
option ñSelect User Columnsò. 

 

 

 

The width of each column can be adjusted and the order of the columns can be changed using 
"Drag and Drop". With "Reset Column widths" and "Reset ColumnOrder" the original state of the 
column widths and the original state of the column order can be restored. 
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The following table describes each data field of the main data table. 

Data field Description 

Image filename Name of the image 

Object name Name of the main object, which is visible in the image 

Object type Object type (e.g. Galaxy, Emission Nebula,..) 

Object class Classification of the object (e.g Hubble class of a galaxy; Trumpler 
class of an open star cluster,é) 

Ra Right ascension [h] 

Dec Declination [°] 

Constellation Name of constellation (e.g. Andromeda) 

Object size Object size [arcmin] 

Magnitude Magnitude [mag] 

Surface brightness Surface brightness [mag/arcmin2] 

Nebula brightness Nebula brightness [1 = very bright; 6 = very faint] 

Image SeqNr Picture sequence number (highest image number in database)  

Object comment Comments concerning the object (e.g. discovered in year 1960) 

Exposure Exposure time [free description] 

Total exposure Total exposure time [min] 

Camera Product name of the camera 

Resolution Resolution mode (e.g. Binning) 

Observation date Observation date 

Additional obs. date Additional observation date 

Telescope Product name of the optics (telescope or photo lens) 

Aperture Aperture [inch] 

Focal Length Focal length [mm] 

Setup info Further information concerning setup (telescope + camera + mount)  

Location Location of image acquisition 

Level over sea Level over sea of location [m] 

Filter Used filters (e.g. Ha, OIII,é) 

Mount Product name of the mount 

Image comment Further comments (e.g. weather conditions) 
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Only the Object-ListView is available in the ObjectBrowser. 

 

With a simple click on the header of a data field (e.g. Total exposure) you can sort the data rows 
in alphanumeric order (ascending and descending). 

 

 

 

Alternative view of the main data table: 

The key combination Ctrl + Space can be used to switch between two different views of the main 
data table: 

¶ Column view (default): As described above 

¶ Compact view: All data fields of the active data record are visible at once. 

 

 

3.4. Extended Information 
The Extended Information table (in the upper right corner of the Browser window) displays the 
following additional information, if available: 

¶ Object: The main object of the active image. 

¶ Photographer(s): Photographer(s) of the active image. 

¶ Additional Objects: Listing of the additional objects in the active image (in the following 
example, the main object is NGC 7129 and the objects LDN 1183 and NGC 7142 are 
also shown in the image). 

¶ Alias names: Listing of all alternative names (alias) of the main object, which are 
contained in the database of CCD-Guide.  

¶ Object relation: Listing of all objects contained in the main object. 

¶ Source: master.mdb or user.mdb 
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For images with wcs-Info the text "more..." is displayed at Additional objects at the end of the 
object list. A click on "more..." returns all objects that CCD-Guide knows in the image field. 

 

 

As soon as you click on an object name with a blue color in the Extended Information area, 
filtering is performed on this object name.  

As soon as you click on a photographer with a blue color in the Extended Information area, 
details such as web or e-mail are displayed. 
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3.5. Images in Imagebrowser 
In some data sets, two preview images appear: A main image on the left and an additional 
image on the right. Double-clicking on one of the preview images always opens the image 
viewing software ObjectViewer. The additional images provide supplementary information to the 
main image: e.g. object identification, an inverted display, ... 

If more than one additional image exists, arrow keys appear in the right preview image. With 
these arrow keys you can navigate through the additional images. The following example shows 
the galaxy cluster Abell 2218, where two additional images are linked to the main image. 

 

 

If the file name displayed under the preview image is marked blue (as is the case with the image 
on the left in the example above), this means that the image contains wcs information and that 
you can start the ObjectMarker directly by clicking on the file name (for details on the 
ObjectMarker, see Chapter 13). 

There is a chain symbol to the right below each preview image. If you click on the symbol, you 
can activate or deactivate the object link function. Green means active. When active, object 
names are displayed in the preview image when the mouse pointer is positioned over the object 
in the image or over the object name in Extended Information. 
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If you press the right mouse button on a preview image, a context menu with two entries 
appears: 

¶ Export Image: to export the image 

¶ ObjectMarker: to open the image in ObjectMarker. 

 

3.6. Filter 
CCD-Guide offers five different possibilities to filter the main data table (reduce number of visible 
datasets): 

¶ Objectname Filter 

¶ MasterObject Filter 

¶ Circular Search Radius 

¶ Quick Filter 

¶ Set Filter 

The Objectname Filter is a very useful feature, if you are interested in all images, which show a 
particular object. First choose the Objectname Filter, then enter the object name (e.g. M 82) in 
the white edit field to the right and press the return button on your keyboard. 

 

 

Now the text ñM 82ò is shown in bold letters, which indicates that the Objectname Filter is active. 
The main data table contains only those images in which the desired object (e.g. M 82) is visible. 
There are also some images listed with Object name = M 81. This means that these images 
contain both objects (M 81 and M 82). 
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With the Reset Filter button you can reset the filter and all images are visible in the main data 
table. If you want to learn more about the nomenclature of objects in the database of CCD-Guide 
and if you want to use the powerful wildcard search then please have a look at chapter 4. 

Tip: Using the keyboard keys "Page up" / "Page down", you can easily switch between the 
previously set Objectname filters. 

 

The MasterObject Filter is used to list all datasets in which the object you are looking for 
appears exclusively as the main object. If, for example, we enter the object M 82 in the 
MasterObject Filter, the main table will show significantly fewer data rows, because only those 
data rows are displayed in which Object name = M 82. 

 

 

 

The Circular Search Radius filters all objects that are within the radius of a specific reference 
object. In the following example, all objects are searched that are located within a radius of 300 
arc minutes around M 94. 
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The Circular Search Radius Filter can also be used in combination with the planetarium. If one of 
the planetariums The Sky6/X or SkyChart is set in the options and this planetarium is open, then 
the position set in the planetarium can be transferred to the Browser by pressing the key 
combination Ctrl+P and a Circular Search Radius search is started automatically. 

 

The Quick Filter is a very fast and efficient way to reduce the number of data rows in a main 
data table. When you enter a search string into the edit field of the QuickFilter, then only those 
data rows are shown which contain this search string in one of the data fields. In the following 
example all data rows are shown which contain the text ñNamibiaò in one of the data fields. The 
search text is shown in bold letters, which indicates that the Quick Filter is active. 

 

 

 

You can also search for several keywords at the same time by linking the search texts with the 
"|" sign (logical OR) or with the "&" sign (logical AND). 

The following example searches all data rows which contain the text ñNamibiaò or the text 
ñChileò.  

 

 

 

The following example shows an AND search. With an AND search, the number of records 
found is significantly reduced. 

 

 
 

The Set Filter button opens the Set Filter window, a very powerful tool to filter your data rows 
using many different criteria (e.g. coordinates, object type, object size, constellation, catalogue, 
observer, camera, telescope, date). Bold characters of the Set Filter button indicate an activated 
filter. Set Filter is explained in detail in chapter 5.  

There are two integrated quick filters in the Objectname Filter, which provide functions from the 
Set Filter: 

¶ Constellation quick filter: As soon as the abbreviation of the constellation (per, ori, ...) is 
entered in the input field, all objects of the constellation are filtered. This is the same 
functionality as when filtering on the constellation in the Set Filter. 
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¶ Observer quick filter: As soon as the hash sign "#" is entered in the input field, all images 

of the observer selected in the Global Settings of CCD_Guide.exe are displayed in the 
ImageBrowser. 

 
 

 

 

3.7. Actions 
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The Slide Show button  creates a slide show of all visible images in the main data table. For 
example, if M 82 has been filtered, a click on Slide Show starts a slide show with all images of M 
82 in full screen mode. 

The Preview Panel function  provides a thumbnail overview of all images in the main table in 
full screen mode.  

 

The button ñ>>>ò contains functions which are related to the active (blue coloured) data set: 

¶ Planetarium: The Planetarium button opens your preferred planetarium software centred 
on the active object. Use Options to define your preferred planetarium software (chapter 
2).  

¶ Sky-map.org: When you are connected to the internet then you can use the Sky-
map.org button to open sky-map.org centred on the active object. 

¶ Aladin Lite: If there is an internet connection, then the Aladin Lite button can be used to 
open Aladin Lite centred on the active object. 

¶ ObjectTracker: The ObjectTracker button starts ObjectTracker with the active object. 
ObjectTracker answers the question whether and when the selected object can be 
photographed well. Details on how to use ObjectTracker can be found in chapter 11. 

¶ ObjectMarker: The ObjectMarker button copies the currently selected image to the 
output\markerimages directory and starts the ObjectMarker. With the ObjectMarker the 
image can be solved if necessary. Then a labelled version of the image can be created in 
the ObjectMarker. Details on how to use the ObjectMarker can be found in chapter 13. 

¶ Export to Planner: Use the Export to Planner button to export the active object to the 
Planner tab of CCD-Guide Expert. The Planner tab is described in detail in chapter 6. 

¶ Export Image Data: The active data record or the entire table can be exported. 

 
The function "Batch Solve filtered images" is the only function of the button ">>>" that does not 
refer to the active data set but includes all filtered data sets. As soon as you click on this button, 
the BatchSolver opens with all images of all filtered data sets. A description of the BatchSolver 
can be found in chapter 16. 

 

3.8. ObjectBrowser 
If you are already familiar with the ImageBrowser, then the usage of the ObjectBrowser is very 
easy. The only difference is that now all objects of the database are listed in the main data table 
regardless of whether images of these objects exist or not exist. If an excellent image of an 
object is available in the CCD-Guide database, then this image is shown in the preview image. 
The ObjectBrowser shows always only one image of an object even if more images of this object 
exist.  
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3.9. Web-Mode 
The area of the two preview images is used by default to display images associated with the 
active data set. This standard mode (also called Local-Mode) was described in the previous 
chapters. The Local-Mode is represented by a blue house symbol. 

 

 

As soon as you click on the mode switch button, the Browser switches to Web-Mode 
(symbolised by a blue globe). 

 

 

In Web-Mode, the area of the two preview images is used to display information on the selected 
object from web services such as sky-map.org, Aladin, SIMBAD or NED. 

The WebViewer (sky-map.org or Aladin) is displayed in the left-hand area and the WebDatabase 
(SIMBAD or NED) is displayed in the right-hand area. 
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The WebViewer displays the field around the object of the active data set. The WebViewer 
including the zoom level can be selected in the Options. It is easy to pan and zoom. 

 

The WebDatabase lists all objects found within one arc minute around the object of the active 
data set. The search radius can be changed at any time and a new search can be started. The 
WebDatabase can be selected in the Options. 

 

Attention: A change of the WebViewer from sky-map.org (default) to Aladin or a change of the 
WebDatabase from SIMBAD (default) to NED requires an installation of Microsoft Edge 
WebView2. 

 

The Web-Mode is a very useful tool, especially when using the ObjectBrowser, where no images 
are available for many objects. 

 

3.10. Archive images 
In order to be able to use the archive images in the Browser, a change in the options is 
necessary: 
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The Database section contains the Archive parameter, which can have three different settings: 

¶ Exclude_Archive (default): Archived data sets are not displayed. 

¶ Only_Archive: Only archived datasets are displayed in the ImageBrowser. 

¶ Include_Archive: All datasets are displayed (both archived and non-archived datasets). 

 

3.11. ShortCut key combinations 
There are a number of short-cut key combinations in the Browser. To be able to look up the key 
combinations quickly, there is a keyboard symbol to the right above the Extended Information 
area. As soon as you move the mouse pointer over this keyboard symbol, you will see an 
overview of all the keyboard shortcuts available in the Browser. 

 

 

 

3.12. Working parallel with Expert and Browser 
If you have opened the Expert and the Browser and you save changes in the Expert, the data in 
the Browser is deliberately not updated automatically so that the filter statuses and the active 
data record in the Browser are always retained.  

After a change to the user.mdb, a red refresh button appears in the Browser to the right of the 
Actions button. 

 

 

The red button indicates that the database in the Browser is not up to date. As soon as the red 
button is clicked, the database is updated and the red button disappears. 
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4. OBJECT NAMES IN THE DATABASE 

4.1. Catalogues in the object database 
CCD-Guide contains a big database of objects including object data. The database contains 30 
different catalogues of deep sky objects, which are based on the revised NGCIC catalogue of 
Wolfgang Steinicke, the nebula database of Eric-Sven Vesting and the NED and Vizier 
databases. A big advantage of CCD-Guide is that there exists only one data row for one object. 
Each physical object has a master object name, but you can find this object also with the alias 
names (entries in other catalogues). 

The following table summarizes the standard catalogues of deep sky objects. You can find one 
example for an object name in the last column (The catalogue name is always followed by a 
blank character).  

Catalogue Description Example 

ABELL Rich Clusters of Galaxies ABELL 426 

ARP Arp's Peculiar Galaxies ARP 268 

BARNARD Barnard's Dark Nebulae BARNARD 72 

CED Cederblad Catalogue of Bright Diffuse Galactic Nebulae CED 106n 

CG Cometary Globules CG 4 

CONST Constellation CONST And 

DCLD Catalogue of Southern Dark Clouds (Hartley+ 1986) DCLD 247.5-12.3 

DG Dorschner+Gurtler Reflection Nebulae DG 21 

DWB Dickel, Wendker and Bieritz HII Regions DWB 111 

GN Atlas of Galactic Nebulae GN 07.12.8 

GUM Gumôs catalogue of southern H-Alpha nebulae GUM 12 

HCG Hickson Compact Groups of Galaxies HCG 45 

HH Herbig-Haro Catalogue HH 46 

IC Index Catalogue IC 430 

LBN Lyndôs Catalogue of Bright Nebulae LBN 999 

LDN Lyndós Dark Nebulae LDN 123 

M Messier M 17 

NGC New General Catalogue NGC 78A 

PGC Principal Galaxies Catalogue (LEDA) PGC 10001 

PK Perek and Kohoutekôs Planetary Nebulae PK 130-10.1 

RCW Rodgers, Campbell and Whiteoak southern HII regions RCW 102 

RNO Red and Nebulous Objects in Dark Clouds (Cohen) RNO 40 

SANDQVIST Sandqvist + Sandqvist-Lindroos Southern Dark Clouds SANDQVIST 161 

SH2- Sharpless Catalogue of HII Regions SH2- 87 

UGC Uppsala General Catalogue of Galaxies UGC 6514 

VDB Van den Bergh's Reflection Nebulae VDB 23 

VDBH Van den Bergh + Herbst Reflection Nebulae VDBH 80 

    

The following table summarizes special catalogues of deep sky objects. 

Catalogue Description Example 

GCL Globular Star Clusters - Collection of Catalogues GCL Terzan 9 

OCL Open Star Clusters - Collection of Catalogues OCL Stock 23 

PN Planetary Nebulae - Collection of Catalogues PN Abell 4 

NAME Common or historical name NAME Barnardôs Galaxy 

UNLISTED 
UNLISTED objects are not included in the standard 
catalogues of CCD-Guide 

UNLISTED LMC 
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The catalogues GCL, OCL and PN are collections of catalogues. GCL is based on the óCatalog 
of parameters for Milky Way globular clustersô by William E. Harris and contains for example the 
globular clusters of the Palomar and Terzan catalogues. OCL is based on óOptically visible open 
clusters and Candidatesô by Dias+ and contains for example the open star clusters of the Stock, 
Berkeley and Trumpler catalogues. PN is based on the óStrasbourg-ESO Catalogue of Galactic 
Planetary Nebulaeô by Acker+ and contains for example the planetary nebulae of the Abell 
catalogue. 

The NAME catalogue is a collection of common or historical names of deep sky objects. The 
UNLISTED catalogue is a possibility to enter further objects which are not included in the 
standard catalogues of the CCD-Guide database. 

 

The following table summarizes catalogues of solar system objects. 

 

Catalogue Description Example 

COMET Comets COMET C/2009 P1 

SOLAR Solar system objects except comets SOLAR Jupiter 

 

4.2. Objectname function 
The object name function is used to find and to select a specific object with the help of an object 
name. This function can be found, for example, in the Objectname Filter. 

If a correct CCD-Guide designation of the object is known (e.g. VDB 33), then it is sufficient to 
enter this name in the Objectname field and then to press the return key (ENTER) on the 
keyboard. 

 

 

If the objectname is unique and CCD-Guide finds exactly one object that matches the search 
query, then this object is immediately set in the Objectname field in the Browser. In the example 
below, only one object was found. VDB 33 is an alias for the object NGC 1788, a reflection 
nebula in the constellation Orion, and therefore was filtered to the object NGC 1788. 

 

 

4.3. Alias names for catalogues 
You can search for an object using the óofficialô catalogue name or using an alternate name for 
the catalogue. E.g: The óofficialô catalogue name in the CCD-Guide database for Barnardôs Dark 
Nebulae Catalogue is óBARNARDô. So the object with number 99 in Barnardôs Catalogue is 
named óBARNARD 99ô.  The catalogue name óBô is an alternative catalogue name for 
óBARNARDô in the CCD-Guide database. So, you can use the short form óB 99ô instead of 
óBARNARD 99ô to find this object.   

The following table lists all alias names for catalogues in the first column (Name) and the official 
catalogue name in the second column (CatType). 
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Name CatType 

MESSIER M 

ACO ABELL 

N NGC 

I IC 

APG ARP 

HICKSON HCG 

SHARPLESS SH2- 

S SH2- 

CEDERBLAD CED 

COHEN RNO 

B BARNARD 

LEDA PGC 

 

Examples: 

Input the short form óN 778ô for the object name to find óNGC 778ô.  

óS 101ô is an alternative to the official name óSH2- 101ô. 

óB 99ô = óBARNARD 99ô. 

4.4. Objectname search with wildcard search 
The wildcard search is very powerful and helps you to find an object, when you do not know a 
correct name of the object in the database of CCD-Guide. If you include one or more * 
characters in the Find Object text field, then the * character is interpreted as a wildcard 
character. CCD-Guide substitutes this * wildcard character by any subset of possible characters, 
when you enter RETURN. 

Below you can find some examples for the usage of the wildcard search. 

 

Object search with common names: 

Only a common name of the object is known (e.g. Perseus galaxy cluster, Horse head nebula, 
Comet Holmes, Holmberg IX). The best way is to put an important part of the common name 
between two * characters. E.g. input *perseus* in the Objectname text field and enter return.  

 

 

A new window appears which shows you all objects which contain the string óperseusô in their 
object name or in their alias object names. 

Three objects are listed:  

¶ OCL Melotte 20 = open star cluster Alpha Perseus 

¶ ABELL 426 = Perseus galaxy cluster 

¶ NGC 1275 = galaxy Perseus A 
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So, the third entry in the list is our searched object. Click on the data row of ABELL 426 and then 
push the Browser select button to select ABELL 426. 

To find Comet Holmes input *holmes* and you will get the searched comet 17P (Holmes). 

To find Holmberg IX input *holmberg* and you will get a list of the nine Holmberg galaxies. 

 

Object search with unknown catalogue name: 

You know the object name, but you are not sure about the catalogue name in CCD-Guide (e.g. 
you are searching for the open star cluster Stock 23 or the planetary nebula Abell 4). 

To find Stock 23 input *stock 23 in the Objectname text field and enter return. You will get one 
object (OCL Stock 23). 

To find the planetary nebula Abell 4 input *abell 4 and you will get two possible objects: 

¶ ABELL 4 = galaxy cluster 

¶ PN Abell 4 = our searched planetary nebula 
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5. SET FILTER 
The Set Filter window can be opened by clicking on the Set Filter button in the Browser or in the 
following tabs of the Expert: Planner, Edit Object and Edit Picture.  

 

 

The Set Filter window opens the possibility to set one or more filters on the main data table. The 
filter criteria are divided in three groups: Object related criteria, image related criteria and 
planner related criteria. Planning criteria are only available in the Planner of the Expert (see 
chapter 6). All filters are combined with a logical AND. 

The following screenshot shows the Set Filter window opened inside the ImageBrowser. When 
you open Set Filter inside the ObjectBrowser, then only the object criteria are relevant and so 
the images criteria are invisible.   

 

 

 

After you have input your desired filter criteria, you activate the filters by pushing the Set Filter 
button. To reset all filter criteria click Reset Criteria. 

You can use the buttons Save Filter and Delete Filter to save and delete filter settings. This is 
very useful, if you create many complex and powerful filters. 
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The following screenshot shows an example for object criteria. Those images are filtered whose 
main object fulfils the following criteria: 

¶ Object type is globular star cluster or open star cluster. 

¶ Declination is larger than 20°. 

¶ Object size is larger than 20 arcmin and smaller than 40 arcmin. 

 

 

 

The following screenshot shows an example for images criteria. Those images are filtered which 
fulfil the following criteria: 

¶ Captured with a Newtonian telescope and with a QSI 660 camera. 

¶ The image is captured after 2022-01-01. 
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6. EXPERT: PLANNER 

6.1. Overview 
The Planner tab of Expert helps you to maintain your todo list of objects. It can help you to 
answer the question: Which object should I capture tonight? All entries are saved in the user 
database (user.mdb). 

The concept of the planner is based on the idea that you want to capture a particular object with 
a certain setup of your equipment. In Expert a setup is a combination of a telescope and a 
camera using a particular focal length. So, before you can use the planner you have to create 
your personal setups in the Edit Setup tab of Expert (for details see Chapter 7). 

The Planner tab is divided in three sections: 

1. Edit frame (top frame): The edit frame gives you the possibility to edit all data fields 
including the two optional planner images (FOV Image and Ref Image) of a particular 
planner data row. To the right of the edit frame the two optional planner images of a 
planner data row are shown. A double click into the thumbnail image opens the 
image in ObjectViewer. The FOV Image shows the field of view and the Ref Image 
can be used to save a reference image. 

2. Filter and info button line: Below the edit frame you find to the left all buttons for 
searching and filtering the planner data rows (Objectname Filter, Quick Filter and Set 
Filter) and to the right the Slide Show button and the info button ñ>>>ò.   

3. Planner data grid (bottom frame): The planner data grid shows all filtered planner 
data rows. The active planner data row is blue coloured and this data row can be 
edited in the edit frame. 
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6.2. Create a new planner data row 
To be able to create a new planning data set, you must first create at least one setup in the "Edit 
Setup" tab (Details in chapter 7). 

First, click New (to the right of the data table). Then all data fields in the edit frame are 
automatically cleared and you can start with your inputs. All blue coloured fields are must fields, 
white coloured fields are optional. First choose your desired setup in the dropdown box. After the 
selection of the setup you can see some details about your setup to the right of the setupname. 

 

 

The next step is to set the object. To set an object, first enter the object name in the white field to 
the right of the Set Object button and then click Set Object or enter return. The Set Object 
function is described in detail in chapter 4. 

 

 

The state field is the third must field which is necessary to define a planner data row. A planner 
data row can have seven different default states: 

 

 

These states can be edited or extended in the Edit Setup tab if required (Details in chapter 7). 

 

Setting a FOV Image (field of view image) or a Ref Image (reference image) is an optional step, 
but very useful step. When you push the FOV Image button, then the FOV Image window 
appears. 
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On the left side of this window you can find the FOV Image parameters, which are already filled 
with useful default values. If necessary, then you can modify the centre coordinates of the 
image, the field of view, the rotation angle of your camera, the height and the width of the FOV 
image and the server, which is used for downloading the DSS2 image from sky-map.org. When 
you push the Update button, then the download process is started. The Reset button resets all 
FOV image parameters to the default values. A red cross indicates the position of the new image 
centre. You can move the red cross by clicking the right mouse button or by pushing the arrow 
keys. After having moved the image centre you have to push the Update button to get the 
updated image. After pushing the Ok button the window is closed and the FOV Image is set. 
Please, activate the option ñAdd FOV Image parameters to Planner Commentò, if you like to 
have the centre coordinates inside the Planner Comment. After having closed the FOV Image 
window by pushing the Ok button, you can see your FOV image in the FOV Image tab. The red 
coloured text ñImage not savedò indicates that you have to push the Save button to save this 
FOV image in your Planner Image Path. 
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If you have an image of the desired object of another astrophotographer, which you want to use 
as a reference, then you can include this image in the planner data row as a Ref Image. After 
pushing the Ref Image button a window for selecting the image appears. You can find the path 
of the selected image in the Image From field. Below the Image From field you can find the 
imagename field. The selected image is copied into the Planner Image Path and renamed, when 
you click Save. You can change the Planner Image Path in the Options tab. 

 

 

As soon as a reference image exists for a data set, the Ref Image tab is marked with a "[+]". 

 

 

The comment field is helpful for additional information (e.g. filters,..). With a double click into the 
Comment field you can open a window with a much bigger edit field. 

When you are finished with your entries, then click Save to create the data row and to copy the 
optional FOV Image and the optional Ref Image into the Planner Image Path. 

6.3. Create new planner data rows with ObjectBrowser 
If you want to include many objects with particular criteria in your todo list, then you can use the 
Export to Planner button inside the ObjectBrowser. First switch to the Browser and select 
Browse mode ObjectBrowser. Then filter the objects by using the Set Filter function. After you 
have reduced the number of objects to a manageable number, you can select an object and 
click the >>> Export to Planner button. The Export to Planner button opens Expert with the 
Planner tab and sets the desired object. The following example shows the state of the Planner 
tab after clicking the Export to Planner button inside the ObjectBrowser (object ABELL 1000 was 
selected in ObjectBrowser). 
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After you have input the missing entries you click save to create the planner data row. Now, you 
can go back to the ObjectBrowser to export the next object into the Planner. 

6.4. Edit and Delete planner data rows 
If you want to edit a planner data row, then first activate the desired data row by clicking on the 
data row or by moving the cursor to the row using the arrow keys. The blue colour always 
indicates the selected data row. As soon as a data field is changed, a red text "Data not saved!" 
appears. This is a hint for the user not to forget to press the Save button. After finishing the 
editing operations, the changes must be saved by pressing the Save button. 

If you want to delete a planner data row, then first activate the desired data row. Then click on 
the Delete button to delete the selected planner data row. The optional planner images 
connected with the planner data row are also deleted. 

6.5. Filter the planner data rows 
If you have a big todo list of objects including many different setups, then it helps to reduce the 
list using filters. You can use the Objectname Filter, the Quick Filter or the Set Filter button in the 
same way as used in the Browser. 

When you use the Objectname filter, then all data rows for the selected object are shown. The 
following screenshot shows the result of an object filter for óAbell 2151ô. 
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The Set Filter button opens the Set Filter window, where you can set object criteria and planner 
criteria. The following screenshot shows the planner criteria with two selected setups and a 
restriction of the state to ó0 ï Image is missingô.  

 

 

 

If the number of planner data rows is still too big, then you can set object criteria like coordinates 
or object type additionally to the planner criteria.  

The Quick Filter can be very useful, when you use some keywords in the Planner comment field 
of important data rows. (E.g. ñPrio1ò). 

You can also search for several keywords at the same time by linking the search texts with the 
"|" sign (logical OR) or with the "&" sign (logical AND). 

The following example searches all data rows which contain the text ñNamibiaò or the text 
ñChileò.  

 

 

 

The following example shows an AND search. With an AND search, the number of records 
found is significantly reduced. 
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If you click on the header of a data column, then you can sort the list ascending or descending. It 
makes sense to sort the list by right ascension. 

The Reset Filter button deactivates all active filters. 

6.6. Slide Show and ó>>>ô-Button 
The Slide Show, Planetarium, sky-map.org, ObjectTracker and ObjectMarker buttons have the 
same function as in the Browser. 

The Planetarium button opens your preferred planetarium software centred on the active object. 

When you are connected to the internet then you can use the sky-map.org button to open sky-
map.org centred on the active object. 

The ObjectTracker button starts ObjectTracker with the active object. 

The ObjectMarker button is only available, when a FOV image is assigned to the active planning 
data record. As soon as you click on the ObjectMarker button, ObjectMarker is opened and the 
FOV image is set. 

6.7. ListView 
The ListView button offers you to choose between two possible layouts of the main data table: 

Standard and User defined. 

6.8. Export csv and Export OT 

¶ You can export the main data table into a csv file by clicking on the button ñExportò. 

¶ The button "Export OT" exports the objects of the table into the catalog _CCD_Planner of 
the file \userdata\cat\cat.mdb. How to use the catalog _CCD_Planner in the 
ObjectTracker efficiently for planning purposes is described in detail in chapters 11. 
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7. EXPERT: EDIT SETUP 
The Edit Setup tab of CCD-Guide is necessary to create new cameras, new telescopes, new 
observers and new setups. All entries are saved in the user database (user.mdb). 

 

 

7.1. Cameras, telescopes and observers 
If one of your cameras is missing in the master database, then click New (the button to the right 
of the camera list). Input the name of the camera in the Key field. Please, use the official name 
of the manufacturer. The input fields Description, ChipSizeX and ChipSizeY are optional. Then 
click Save. 

If one of your telescopes is missing in the master database, then click New (the button to the 
right of the telescope list). Input the name of the telescope in the Key field. Please, use the 
official name of the manufacturer. The input field Description is optional. Then click Save. 

Use the same procedure to input a new observer. First, click New, then input all fields, and then 
click Save. 

You are only allowed to edit your own data rows (SOURCE = USER) of the tables cameras, 
telescopes and observers. First, select your data row (indicated by the blue colour), then edit the 
input fields, and then click Save. 

Tip: It makes sense to mark your own data rows (e.g. use the leading character ó_ô in your 
key fields. So, you can easily identify your cameras, telescopes and observers. 
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You can delete the active data row by clicking on the Delete button. Be careful with deleting 
data rows! All images and planner data rows which are connected with the deleted data 
row are also deleted. 

7.2. Setups 
Setups are needed for the planner. The concept of the planner is based on the idea that you 
want to capture a particular object with a certain setup of your equipment. In CCD-Guide a setup 
is a combination of a telescope and a camera using a particular focal length. 

To create a new setup click on the New button (the button to the right of the setups list).  Now 
you can enter a name for your setup. (Tip: Use a self-descriptive short name: e.g.  
Newt_QSI660). Then choose the telescope and the camera in the drop down lists. The focal 
length is an optional input field. After you have input all data, you can save your setup by clicking 
on the Save button. 

If you want to edit a particular setup, click on the desired setup in the setup data table. This data 
row will be blue coloured, which indicates that this data row is activated. Now, you can edit all 
input fields. Click the Save button to save your modifications. 

If you want to delete a setup, then click the Delete button after you have activated the desired 
setup data row. Be careful with deleting setups! The todo list of objects (planner data 
rows), which is connected with the deleted setup, is also deleted.  

 

7.3. Edit State 
To the right of the Setups area, you find the "Edit State" button. This button can be used to edit 
or extend the default Planner states. After pressing the "Edit State" button, the following window 
opens: 
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For example, you could create a new state 7 = Prio1 and a new state 8 = Prio2, in order to be 
able to mark planning data sets with different priorities. 
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These new states are then available in the Planner tab for each planning data set in the State 
field. 

 

 

 

If you only want to see the planning data sets with Prio1 and Prio2, then set the corresponding 
checkboxes in the State field in the Set Filter window. (Multiple selection possible). 
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8. EXPERT: EDIT OBJECT 

8.1. Create new object 
The Edit Object tab is the fourth tab of CCD-Guide. With this tab you can create new objects 
which are missing in the master database. These new objects are saved in the user.mdb. 

 

 

First, click the New button. Then select the catalogue. You have three options: 

¶ COMET:  the new object is a comet. Please, enter the name using the nomenclature of 
the Minor Planet Center (e.g. C/2009 P1, 17P) and the Cometname (e.g. Garradd, 
Holmes). Then click Save. 

¶ SOLAR:  the new object is a minor planet. Please, enter the name of the minor planet 
(e.g. Vesta). Then click Save. 

¶ UNLISTED: the new object is a deep sky object. Please, enter the name of the object 
and the object type. All other fields are optional. (Must fields are indicated by the blue 
colour. Optional fields are white. A detailed explanation for all optional fields can be 
found in chapter 3.3) Then click Save. 

 

In the UNLISTED catalog, two useful buttons are available in the upper left corner: 

¶ Get Pos: With this button coordinates in SIMBAD format can be fetched from the 
clipboard. Example: On the SIMBAD page, the coordinates of the object UGCA 342 are 
first copied into the clipboard. Then these coordinates are set by pressing the "Get Pos" 
button in the Edit Object tab.  
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¶ Set Const: Pressing this button sets the constellation based on the currently active 
coordinates. 

8.2. Edit and delete an existing object 
The data table of the Edit Object tab lists all objects of type COMET, SOLAR and UNLISTED 
which can be found in the master database and the user database. When you are working with 
the Edit Object tab, then you are automatically in the edit mode of an object data row. The blue 
colour indicates the active data row. You can change the active data row by clicking with the 
mouse or by pressing the arrow keys of your keyboard.  

You will notice that you cannot edit or delete objects with SOURCE = MASTER. When you 
activate an object data row with SOURCE = USER, then you can edit the data fields. When you 
click Save then the modifications of the data fields are saved. When you click Delete, then this 
data row will be deleted. 

8.3. '>>>'-Button 
The buttons Planetarium, sky-map.org, ObjectTracker and "Export to Planner" have the same 
function as in the Browser. 

8.4. ListView 
The ListView button offers the possibility to choose between two different designs of the object 
data table: Standard and User-specific. 

8.5. Export csv and Export OT 

¶ The "Export" button allows to export the main data table to a csv file. 

¶ The "Export OT" button exports the objects of the table to the _CCD_User catalog in 
cat.mdb (\userdata\cat.mdb). The _CCD_User catalog can be used in the ObjectTools 
like ObjectTracker or ObjectMarker (details in chapter 11 and after). 
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9. EXPERT: EDIT PICTURE 

9.1. Overview 
The Edit Picture tab of CCD-Guide is necessary to create new image data rows. All entries are 
saved in the user database (user.mdb). 

Before the first image can be entered, a new observer must be created in Edit Setup (see 
Chapter 7 for details). 

There are two possibilities to create a new picture: 

¶ New button 

¶ Clone button 

 

9.2. Create a new picture with New button 
First, click New (to the right of the data table). Then all data fields are automatically cleared and 
you can start with your inputs. All blue coloured fields are must fields, white coloured fields are 
optional. The best way is to start with the input of the object name. You can see that the 
Objectname data field (top left corner) is grey, which indicates that direct input is not possible. 
To set an object, first enter the object name in the white field to the right of the Set Object button 
and then click Set Object. The Set Object function is described in detail in chapter 4. 

E.g.: If you want to enter a picture of NGC 4435, then first click New, then enter óNGC 4435ô in 
the white Set Object field and push the Set Object button. Now you can see that the object NGC 
4435 is selected. 
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Below the Objectname you can find the Picturename. CCD-Guide suggests óNGC4435ô for the 
picture name. You can rename the picture name. (E.g. óNGC4435-1ô to indicate that this is the 
first image, which you have captured of NGC 4435). 

The next step is to choose the image. Click Load Image (top right corner) to set the óFrom pathô. 
After you have selected the image, you can see that the óTo pathô is filled. The image will be 
copied from the óFrom pathô to the óTo pathô, when you click Save. But do not click Save now. 
First, we have to enter the other fields. 

 

 

 

You can find a detailed description of the data fields in chapter 3.2. The following screen shot 
shows an example for input data. 

 

 

The last step is to input observers, additional objects and additional pictures. 

You have to use the double arrows to the right of the observer table to add or to remove an 
observer. 

 

 

With a mouse click on the top double arrow you can add an observer. To remove an observer, 
first select the observer in the table and then click on the bottom double arrow. 
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If you want to add an additional object, then first enter the object in the Additional Objects data 
field, and then press return or click on the top double arrow (to the right of the table). 

 

 

To remove an additional object, first select the object in the table and then click on the bottom 
double arrow. 

Additional pictures are pictures which show additional information (e.g object identification, 
inverted image, é). To add an additional picture, click on the Load Image button and select the 
desired additional image. After you have selected the image, you will see that the óFrom pathô 
and the óTo fieldô are filled.   

 

 

Now, you have to modify the óTo nameô. You can enter any image name, but it is a good idea to 
use the suggested image name as base and to add some characters to indicate the type of the 
additional image.  

If you add an additional image, which shows some object identifications then include the string 
ó_idô in the image name ( e.g. NGC4435-1_id.jpg). 

If you add an additional image, which shows the image in inverted mode, then include the string 
ó_invô in the image name (e.g. NGC4435-1_inv.jpg). 

After you have entered the desired name for the additional picture, you should click on the top 
double arrow to include the additional picture in the table. 
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You can add as many additional pictures as you like. The additional pictures are copied from the 
ófrom pathô to the User image path and renamed with the óTo nameô, when you click Save. 

Now, you can click Save to save the data row and to copy and rename all pictures. 

9.3. Create a new picture with Clone button 
The óClone methodô is a very fast approach to create a new picture data row. The idea is to 
select a picture data row which is very similar to the picture data row which you want to create. 
So, you only have to modify the existing data fields, but you do not have to input all data starting 
with empty fields. 

Use the Objectname Filter, the Quick Filter or the Set Filter button to find an appropriate picture 
data row for cloning.  

 

 

Activate a picture data row in the table (indicated by blue colour) and then click Clone. Now, all 
data fields except object names and the picture names are filled with default data.  

The further procedure is very similar to the óNew methodô: 

¶ Set the object name using the Set Object button 

¶ Edit the picture name 

¶ Select the image using the Load Image button 

¶ Edit all other data fields 

¶ Observers, additional objects and additional pictures are input in the same way as 
described with the óNew methodô. 

¶ Click Save to save the data row and to copy and rename the pictures. 

9.4. '>>>'-Button 
The buttons Planetarium, sky-map.org, ObjectTracker and ObjectMarker have the same function 
as in the Browser. 

9.5. ListView 
The ListView button offers the possibility to choose between two different designs of the picture 
data table: Standard and User-specific. 

9.6. Export csv 
The "Export" button allows to export the main data table to a csv file. 
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10. OBJECTTOOLS 

10.1. Introduction 
The ObjectTools are valuable helpers when planning an observation night (ObjectTracker), 
when evaluating and labelling astrophotos (ObjectMarker) and when displaying and analyzing 
astrophotos (ObjectViewer). 

The ObjectTools are an integral part of CCD-Guide and can be used in interaction with the 
Browser or the Expert as well as stand-alone tools. All ObjectTools are located in the CCD-
Guide root directory. Besides the three main applications ObjectTracker, ObjectMarker and 
ObjectViewer there are also a number of additional applications (such as CatEdit, BatchSolver, 
JPEGCompress, WCSCopy or WCSList). Detailed descriptions of the individual applications can 
be found in the following chapters: 

¶ ObjectTracker: Chapter 11 

¶ ObjectMarker: Chapter 13 

¶ ObjectViewer: Chapter 14 

¶ Utilities (CatEdit, BatchSolver, JPEGCompress, WCSCopy, WCSList and Update): 
Chapter 16 

 

All exe files in the CCD-Guide root folder can be started and used at any time by double-clicking, 
even without the CCD-Guide application open. However, it is much more convenient for starting 
ObjectTools applications to use the CCD_Guide.exe. 

 

10.2. Overview of the ObjectTools applications 
Below you can find the ObjectTools applications listed alphabetically. Applications important for 
normal use are marked in bold: 

 

¶ BatchSolver.exe: is a special application for the simultaneous plate solving of a large 
number of images. BatchSolver.exe is not required for normal CCD-Guide use. 

 

¶ CatEdit.exe: is a special application for maintaining and editing the ObjectTools catalogs 
as well as for the download-supported creation of completely new catalogs. For the 
normal CCD-Guide usage CatEdit.exe is not needed. 
 

¶ JPEGCompress.exe: is a useful tool for compressing a large number of jpg images. 
 

¶ Locations.exe: is a component of ObjectTracker for editing the table with the observation 
locations (Locations.csv). Normally there is no need to start the Locations.exe manually. 
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¶ ObjectMarker.exe: With the ObjectMarker images can be solved via astrometry.net and 
then labeled with the objects of the CCD-Guide database as well as with own texts. 
Furthermore, the ObjectViewer can be started to view and analyse the labelled image. 

 

¶ ObjectSky.exe: ObjectSky is a planetarium that works interactively with ObjectTracker. 

 

¶ ObjectTracker.exe: ObjectTracker answers quickly and easily the question whether a 
certain object can be photographed at a selected location in a certain night. The ideal 
time window for observing is calculated taking into account twilight, moon, object altitude 
and optional horizon. The altitude progression of the object and of the moon is displayed 
in an intuitive graphic. 

 

¶ ObjectViewer.exe: With ObjectViewer you can view the images labelled with the 
ObjectMarker, read coordinates and perform an internet search with SIMBAD, NED or 
Vizier. 

 

¶ WCSCopy.exe: is a special application for the transfer of WCS information (World 
Coordinate System) from a solved image to a not yet solved image with the same 
dimensions. WCSCopy.exe is not required for normal CCD-Guide use. 
 

¶ WCSList.exe: is an application with which complete directories can be searched for 
images and the status of the wcs-info can be displayed in tabular form. In WCSList, wcs-
infos of selected images can also be deleted. 

 

10.3. ObjectTools catalogs 
All catalogs stored in \userdata\cat\cat.mdb are available in both the ObjectTracker and the 
ObjectMarker: 

¶ _CCD_Planner: This optional catalog is created when the "Export OT" button is pressed 
in the Planner tab of Expert. All objects filtered in the Planner tab will be exported. 

 
 

¶ _CCD_User: This optional catalog is created by pressing the "Export OT" button in the 
Edit Object tab of Expert. All UNLISTED objects created by the user will be exported. 
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11. OBJECTTRACKER 

11.1. Introduction 
ObjectTracker answers quickly and easily the question whether a certain object at a selected 
location can be photographed in a certain night. The ideal time window for taking photographs is 
calculated taking into account twilight, moon, object altitude and optional horizon. The altitude 
progression of the object and of the moon is displayed in an intuitive graphic. 

ObjectTracker can be started from Browser or Expert (via the '>>>' button) or alternatively as a 
stand-alone tool. To start as a stand-alone tool, double-click on the file ObjectTracker.exe in the 
CCD-Guide root directory or push the ObjectTracker button in CCD_Guide.exe. 

In the following, the use as a stand-alone tool is described first and afterwards practical use 
cases in interaction with Browser and Expert are explained. 

11.2. ObjectTracker main window 
After starting ObjectTracker the following main window appears.  

 

 

 

 

The main window is divided into five areas: 

¶ Graphics area: The graphics area is located at the top. For a selected night, twilight, the 
altitude of the object and of the moon and an optional horizon are displayed here. Red 
triangles indicate the beginning and the end of the object's visibility window. 
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¶ Input area: The input area is located at the bottom left and comprises the two areas with 
the headings ñDeep Sky Objectò and ñDate, Time and Location". Here you can select a 
specific object and set the desired location and date. 

¶ Object visibility area: The object visibility area with the heading ñObject Time Windowò 
is located to the right of the input area. Constraints of the visibility window such as object 
altitude, sun altitude, moon influence or horizon consideration can be set here. 

¶ Info area: The info area is located at the bottom right. Various detailed information is 
displayed here in a scrollable list. 

¶ Status bar: This bar is at the bottom. Here, buttons for special applications are available 
and status indicators are displayed. 

 

By changing any input field, all values and graphics are always completely recalculated. 

 

11.3. Location input 
The first step for using ObjectTracker is to enter the desired location. CCD-Guide is delivered 
with a single location: Gahberg Observatory. If you are not observing at Gahberg Observatory, 
you should first enter your observation location. Any number of observation locations can be 
created so that all users who like to make astro-journeys or have access to remote locations can 
quickly switch between different locations. 

 

Create a new location: 

To create a new location, click on the óEditô button in the "Date, Time and Location" area of the 
ObjectTracker main window. A new window opens, in which the locations are administered. In 
this window only one line with the location "Gahberg Observatory" is visible at the initial start. 
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As soon as you click on the "New" button, you can edit the location data fields in the upper left 
corner. First enter a meaningful name for the location (e.g. "La Palma") in the Location field. The 
geographic coordinates can be set by directly entering latitude and longitude into the Latitude 
and Longitude fields. Alternatively, the entry can also be made using a so-called GeoHash code, 
if this should be known for the new location. By clicking on the "Google" button, the location is 
opened in Google Maps. Next, the sea level in meters is entered in the LevelOverSea field. It is 
important to select the correct timezone. For La Palma the timezone "GMT Standard Time" is 
selected. By this selection the values of TZone, DSTOffset and DaylightName are automatically 
filled correctly. A horizon filename is not set at first. If you also want to create a horizon for the 
newly created location, this is done by clicking the Enable horizon edit checkbox. Entering a 
horizon for a specific location can also be done later. The creation of horizons is described 
below. To save the new location in the Locations.csv file, click Save. The following screenshot 
shows the state after creating the new location "La Palma" without using a horizon.  
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Create a new horizon for a location: 

To enter a horizon, first select the location in the table (data set with blue background). By 
clicking on the checkbox "Enable horizon edit" below the horizon graphic, the horizon can be 
edited. In the following example, the horizon for the location "La Palma" is created. 
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With the pressed left mouse button a horizon can now be "painted". The following example 
shows an approx. 60° high obstacle on the eastern horizon and an approx. 30° high obstacle on 
the western horizon. 
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With button Save the horizon file can be saved. As an alternative to the graphical horizon editor, 
a horizon file can also be created manually by entering exact pairs of values for azimuth and 
elevation in an ASCII file. The corresponding horizon file is located in the \userdata\hor\ folder. 

The creation of the locations is usually a one-time process. When using ObjectTracker on a daily 
basis, it is not necessary to call up the location management. 

 

11.4. Selection of location and date 
When all required locations have already been created, switching between different locations is 
a very simple process. In the "Date, Time and Location" area, select the desired location in the 
Location drop-down field and all values of the location (geographical coordinates and time zone) 
are immediately set correctly. 

 

Attention: The correct setting of daylight saving time / winter time lies in the responsibility of the 
user. This means that after changing the location selection, always check whether the "Daylight 
Saving Time" checkbox is selected correctly. As soon as the check mark is activated, this means 
that daylight saving time is valid. If the check mark is deactivated, ObjectTracker interprets all 
times as winter time. 

 

 

When you open ObjectTracker, the date is set to today's date by default. If you want to make the 
observation planning for another date, then this is done by changing the date field. 

11.5. Deep sky object area 
To select an object, enter the object name (e.g. "M 16") in the Name field. The entry of the object 
name should either be completed with a return or the Find button should be pressed. This 
triggers an object search: 
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¶ ObjectTracker first searches in the CCD-Guide database and in the local catalogs in the 
subdirectory \userdata\cat\ for the object. If the object is found in a local catalog, the 
coordinates Ra and Dec are taken from the local catalog file. 

¶ If the object is not found, another search for the object is performed on the internet, 
provided an internet connection is available. If the internet search is successful, the 
coordinates are taken over. If the search is unsuccessful, the message "Object not 
found" appears. 

The following illustration shows the status of the text input of "M16" before pressing the Return 
key or before clicking the Find button. The yellow background colour indicates that the object 
search has not yet been performed and therefore all output elements have not yet been 
updated. As soon as the update is done, the yellow colour disappears. 

 

 

 

In the Name field, in addition to the objects in the CCD Guide database, you can also search for 
planets and current comets. 
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If the object you are looking for is not found, then it is also possible to enter Ra and Dec 
coordinates directly by changing the input mode from "Find Name" to "Select Ra/Dec". As soon 
as the option "Select Ra/Dec" is selected, the Ra / Dec fields will appear with a white 
background colour and a direct input of Ra and Dec coordinates is possible. 

 

 

 

The contents of all catalogs can be viewed in the browse window, which appears after pressing 
the "Browse" button. 

 

http://www.ccdguide.com/
http://www.ccdguide.com/
http://www.ccdguide.com/


 

 

CCD-Guide 4.3 Manual 

Bernhard Hubl     http://www.ccdguide.com/ 

 2024-09-13 69 / 150 

 

  

In the browse window shown above, the catalogs in the left area can be selected as desired. 
The table on the right lists the objects stored in the selected catalogs. As soon as you click with 
the left mouse button on one of the objects, the ObjectTracker main window is updated with the 
selected object. With the help of various filter options the selection of visible objects can be 
further limited.   

 

In the following example, only Messier objects that are near culmination in the middle of the 
night are filtered. 
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If you click on the report buttons csv or txt, a report in csv or txt format will be created, in which 
the observation data of all selected objects are displayed in tabular form. 
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In addition to the Deepsky catalogs, the Browse window also contains the "Planets" and 
"Comets" catalogs. These two catalogs contain the current positions and magnitudes of the 
planets and the comets. 

 

 

 

Let's switch back to the Deep Sky Object area of the ObjectTracker main window. Below the 
Browse button there are three more buttons, the "AladinLite" button, the "Planetarium" button 
and the ñCCD-Guide Browserò button, which are described in detail below. 
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11.6. Object visibility settings 
After the location, the date and the object have been selected, the constraints for the calculation 
of the visibility time window can optionally be changed. 

 

 

 

The Object Altitude Limit specifies the minimum object altitude required for the object to be 
photographed. The standard altitude is 40°.  

The Moon Distance Limit specifies the minimum distance between moon and object required for 
a useful observation. 

The Moon Illumination Limit indicates the maximum illuminated part of the moon at which an 
observation of the object is still possible while the moon is above horizon. If the moon is brighter 
than the moon illumination limit, an observation of the object is only allowed after moonset or 
before moonrise. The standard value of 30% can be set much higher at a light-polluted location 
or in narrow-band photography. 

The Sun Altitude Limit indicates the altitude below which the sun must fall for the object to be 
observed. The default value is -18°, which corresponds to the criterion for astronomical twilight. 
In the case of narrow-band photography or in the case of a light-polluted location, a larger limit 
(e.g. -16°) can make sense. 

The Horizon Limit checkbox indicates whether the horizon should be considered in the 
calculation of the object visibility window. 

11.7. Graphic area 
After all settings have been made, the resulting graphic can be viewed and interpreted. We will 
look at the following example. 
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The object M 16 is to be photographed during the night of August 18 to 19, 2022 in La Palma. A 
horizon progression has been entered for La Palma and the default limits are used for the 
constraints. 

In the graphic, the time from 20:00 in the evening to 8:00 in the morning is shown on the x-axis 
and the y-axis shows the altitude in degrees.  

Twilight is indicated by the background colour of the graphic. Only in the area of the deep blue 
background the sun has fallen below the Sun Altitude Limit and it is astronomically dark. 

 

Three altitude curves are shown: 

¶ Object altitude (red) 

¶ Moon altitude (yellow) 

¶ Horizon (turquoise) 

The dashed red line, which is drawn horizontally at an altitude of 40°, represents the Object 
Altitude Limit. 

The two red triangles indicate the beginning and the end of the object visibility window. M16 can 
be photographed starting with end of dusk at 22:13. At 22:43 M16 culminates in the south (letter 
"S" above the red curve). At 00:31 the visibility window ends, because at this time the object 
height drops below 40°.  

In the above example, the observation window is not affected by the turquoise horizon. 

The cursor function is particularly useful. If you move the mouse over the graphic area, a green 
crosshair appears, which follows the altitude curve of the object. The following information of the 
current crosshair position is displayed in the bottom line (status bar) of the ObjectTracker 
window: Time, azimuth, altitude and Moon-object distance. 
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11.8. Info area 
The info area contains additional information. Especially useful is for example the distance 
between moon and object. In the considered example, the Moon M 16 distance is 137°. 
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11.9. Time Series 
In the status bar there is a button with a list symbol (Time Series), with which the observation 
window for the selected object can be calculated and visually displayed not only for one night, 
but for a long period of time.  

 

 

After clicking on the Time Series button the following window appears: 

 

   

In the parameter area the start year and the start month as well as the number of months to be 
calculated can be selected. It can also be set whether the changeover to daylight saving time 
should be taken into account in the output and if so, in which period of time daylight saving time 
is active. Click the Create button to start the output.  

Now let's look at the example above (M 16 in La Palma with the standard constraints and active 
horizon). We choose 2022/08 as start date and let the calculation be output for 12 months. After 
pressing the Create-button the window looks like this: 
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The table at the top of the Time Series window lists the observation window and a number of 
other useful information like moon data in chronological ascending order. In the lower area of the 
Time Series window, there is a graphic that shows the course of the visibility window at a glance. 
The example above shows that M16 can be observed for about two hours on nights without a 
disturbing moon in August. The visibility window shrinks to one hour in September and from 
October on the season for M16 on La Palma ends with the constraints set by the user. For all 
observers who prefer to photograph only in a certain telescope position (west or east), the colour 
of the bars is an interesting additional information: Blue indicates the proportion of the 
observation window in the eastern sky and orange the proportion of the observation window in 
the western sky. 

If you scroll to the right in the graphic, then you can immediately see when an observation 
window opens up again in the following season. The example of M16 shows that an observation 
is worthwhile again from May 2023. If one clicks on a certain day in the diagram (in the example 
2023-05-23 shown below), then this day in the diagram is marked with a red dot and at the same 
time the table focus on this selected day. 
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Finally, it is also possible to export the complete list to a csv file by clicking the Export button. 

11.10. OpenWeatherMap 
In the status bar you can find a cloud symbol with which you can display the current weather 
forecast of OpenWeatherMap for the selected location. 

 

 

Before you can use OpenWeatherMap, however, it is necessary to obtain an OpenWeatherAPI 
key and enter it in the Global Settings of CCD_Guide.exe. To do this, go to the ObjectTracker 
tab in the CCD-Guide Global Settings and click on the link "Get an API key (APPID)". 
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This will open the OpenWeatherMap page in your web-browser, where the steps to create an 
account and generate an API key are described in detail. Once the APIKey is entered in Global 
Settings, the OpenWeatherMap functionality is permanently available in the ObjectTracker. 

To display the weather report in the graphic and in the info area, a single click on the clouds 
button is sufficient. 

http://www.ccdguide.com/
http://www.ccdguide.com/
http://www.ccdguide.com/


 

 

CCD-Guide 4.3 Manual 

Bernhard Hubl     http://www.ccdguide.com/ 

 2024-09-13 79 / 150 

 

 

 

With any update of an ObjectTracker input field the weather report disappears again. With a click 
on the cloud symbol button the weather report can be shown again at any time. 

11.11. AladinLite 
In the Deep Sky Object area there is the AladinLite button (button with the satellite dish symbol), 
with which you can start AladinLite. 
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11.12. ObjectSky 
In the Deep Sky Object area, next to the AladinLite button is the Planetarium button (symbol with 
domed building). 

  

 

After pressing the Planetarium Button the ObjectSky window opens: 
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The object selected in the ObjectTracker is centered in the ObjectSky window and displayed 
with crosshairs. In the example shown above, the object M 16 is marked. The position can be 
changed with the help of the two sliders. The position can also be changed using the mouse with 
the middle mouse button pressed. Zooming is also possible with the middle mouse button by 
using the mouse wheel. Zooming can alternatively be done by using the key combination "Ctrl" + 
"+-".  

 

Furthermore, the Object Information window appears, in which the data for the object are 
displayed. With the center button at the bottom left, the object can be centered again if 
necessary. With the SIMBAD button the object can be called in SIMBAD. 

 

 

If you switch from the Data tab to the Image tab, you have access to all images in the CCD-
Guide database. A double click on the preview image or a click on the View button opens the 
image in the ImageViewer. 

http://www.ccdguide.com/
http://www.ccdguide.com/
http://www.ccdguide.com/


 

 

CCD-Guide 4.3 Manual 

Bernhard Hubl     http://www.ccdguide.com/ 

 2024-09-13 83 / 150 

 

 

By default, when you open the ObjectSky planetarium, the location is set to the location active in 
the ObjectTracker and the date is set to the date active in the ObjectTracker (time 00:00). The 
location and date active in ObjectSky are displayed in the ObjectSky title bar. 

 

 

Location, date and time can also be changed in the menu of ObjectSky at any time. By default 
ObjectTracker is the leading system. When changes are made in ObjectTracker, such as object, 
date or location, then ObjectSky updates itself automatically. If this interaction between 
ObjectTracker and ObjectSky is not desired, then this can be set in the Comm menu by 
unchecking the "Accept objects from other programs" checkbox. 

 

In the menu "Find" you can search for a specific object of the CCD-Guide database, for a planet 
or for a current comet. 
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In the menu "Drawings" you can set what should be displayed. 

  

 

 

 

In the "Catalogs" menu, you can set which catalogs are to be displayed. In the following 
example, the objects of the Messier catalog are always displayed. All other objects are only 
displayed if the field of view is smaller than 30°. 
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In the Comets section a list of current comets appears after pressing the ñListò button. You can 
select and display a current comet of this list. With the button "Remove" the selected comets are 
removed again. 

 

 

 

 

In the "Options" menu, various settings can be made for the display of the objects. 

 

http://www.ccdguide.com/
http://www.ccdguide.com/
http://www.ccdguide.com/


 

 

CCD-Guide 4.3 Manual 

Bernhard Hubl     http://www.ccdguide.com/ 

 2024-09-13 87 / 150 

With the "CCD catalog colors" option, the catalog colors can be adopted from ObjectMarker. 

 

In the "Telescope" menu, the "Show telescope frame" checkbox can be used to specify the 
display of the image field of a telescope-camera combination. 

 

 
 
The above setting gives the following result, centered on M 27. 
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With the selection "Image in front" an astrometric image from the CCD-Guide database can be 
selected and displayed. 
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Three functions are available in the "Specials" menu. 

 

 

Galaxy Space View can be used to analyze galaxies in space as soon as Telescope frame is 
activated in ObjectSky. 

 

 

The "Milky Way Globular Clusters in 3D" function offers a 3D view of all globular clusters in the 
Milky Way. 
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